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Présentation de CyberBoard

CyberBoard est un système qui facilite et rend plus agréable la pratique par correspondance ou par courrier éléctronique de wargames et de jeux sur plateau. Le programme permet de réaliser facilement sur ordinateur une version graphique des différentes composantes d'un jeu de plateau (carte, pions, marqueurs). Le joueur peut exécuter son tour de jeu et envoyer à son adversaire un enregistrement de ses actions. L'adversaire peut à son tour revoir le déroulement de ces actions (playback). CyberBoard permet la (re)création de toutes sortes de jeux, mais convient particulièrement bien pour les jeux sur carte de type "wargames".

CyberBoard n'est pas en lui-même un adversaire. Il n'offre pas de possibilité d'intelligence artificielle.

Le but des créateurs de CyberBoard était de reproduire l'expérience naturelle du jeu sur une carte avec des pions – pour autant que ce soit réalisable. Dans sa forme actuelle, le programme assure cette mission de manière tout à fait satisfaisante.

Description du système

CyberBoard reproduit sous forme électronique les constituants réels d'un jeu de plateau. La version CyberBoard d'un jeu se compose essentiellement de trois éléments : un fichier "boîte de jeu" (gamebox) qui contient le ou les plateau(x) de jeu (la carte) ainsi que les pièces, pions et marqueurs, etc.; un fichier "scénario" qui contient la situation de départ d'un jeu ou d'un scénario particulier (carte et pions utilisés, position des unités, etc.); enfin un fichier "partie" (game) qui contient la situation actuelle d'une partie en cours, ainsi que tout l'historique de celle-ci. A cela s'ajoutent les fichiers "tour de jeu" (move) que s'échangent les joueurs à chaque tour de jeu et qui contiennent les actions réalisées ce tour-ci.

En pratique, CyberBoard se compose de deux modules : un programme de création (CBDesign) qui sert à informatiser les différentes composantes d'un jeu (c.-à-d. créer la boîte), et un programme de jeu (CBPlay) qui sert à créer les scénarios et à jouer effectivement une partie par correspondance. 

Caractéristiques du programme de création:

· Editeur graphique bitmap pour la création et la manipulation de plaquettes d'image, qui constitueront les pions, marqueurs et éléments de terrain. 

· Editeur graphique à main libre pour le dessin de lignes, de rectangles, d'ellipses et de polygones sur le plateau de jeu ou sur les plaquettes d'images. 

· Plateau de jeu automatiquement créé à trois échelles : taille normale, demi-taille et taille réduite. 

· Dessin du plateau sur trois couches : un niveau "grille" intercalé entre deux niveaux "dessin à main libre". 

· Possibilité de pions "double face". 

· Marqueurs graphiques disponibles pour le marquage de situations en cours de jeu. 

· Plateaux à grille de cases hexagonales (deux choix), rectangulaires, et "en briques". 

· Bordures des cases dissimulées ou affichées en surimpression, au choix. 

· Possibilité de contraindre les objets dans les cases, ou de glisser librement sur la carte.




Caractéristiques du programme de jeu:

· Editeur de scénario pour fixer les positions de départ d'une partie, et définir les plateaux/cartes et les pièces à utiliser. 

· Echange des tours de jeu par de petits fichiers contenant l'enregistrements des actions, à envoyer à l'adversaire par e-mail ou sur disquette. 

· Jets de dés, servant à la résolution des combats ou à toute autre fonction.

· Empilement automatique des pièces (Auto stack). 

· Retournement des pions double-face. 

· Rotation des pièces pour indiquer l'orientation. 

· Possibilité de déplacements "à la trace", pour permettre à l'adversaire de contrôler le parcours exact suivi par vos unités. 

· Inclusion de messages à tout moment pendant l'enregistrement des actions. 

· Conservation de l'historique de la partie pour consultation ultérieure. 

Système d'Opération
Windows 95, Windows 98, Windows NT Version 4.0 et Windows 2000

Contenu de ce manuel

Ce manuel d'utilisation décrit les caractéristiques du module CBPlay, le programme de jeu de CyberBoard. Chaque commande de menu y est décrite, et un court exemple d'utilisation de CBPlay en cours de jeu sert d'instruction de base. Le lecteur est supposé avoir déjà une connaissance active du système d'opération Windows cité ci-dessus, y compris la gestion de fichiers, l'utilisation de la souris et la navigation dans les répertoires.

CBPlay : Aperçu général

Le module Joueur sert à constituer des fichiers de scénario, et à jouer des parties. Un scénario (fichier à extension GSN) contient les différentes pièces et les plateaux ou cartes qui sont nécessaires à un jeu particulier.  Ces pièces et ces plateaux ont dû être créés à l'aide du module de création CBDesign, et enregistrés dans un fichier "boîte de jeu" (gamebox , à extension GBX). Celui-ci contient toutes les pièces et plateaux utilisés dans les diverses situations de jeu particulières.  Pour construire un nouveau scénario il faut parfois utiliser CBDesign pour en créer les composantes physiques nouvelles, qu'on sélectionnera ensuite dans le fichier scénario.

  Le fonctionnement de CBDesign est expliqué dans un manuel d'utilisation séparé.

Le fichier de partie (game, à extension GAM) conserve l'état actuel de la partie ainsi que l'historique complet de son déroulement.  On peut ainsi réexaminer à tout moment une série de mouvements précédents.

Enfin, pour se communiquer les tours de jeu, on a recours à un fichier "coup" ou "tour de jeu" (game move, extension GMV) qui contient un relevé séquentiel de toutes les actions exécutées depuis la dernière sauvegarde du fichier de partie.



Scénarios

Un scénario (fichier à extension GSN) contient toutes les pièces et les plateaux  nécessaires pour le jeu.  De plus, il définit un certain nombre de conteneurs pour les pièces de jeu, que nous appellerons "casiers de rangement" (en anglais Tray).

Création d'un Nouveau fichier Scénario

1. Dans le menu File, sélectionnez New.  Dans le dialogue New choisissez Scenario et cliquez sur OK.
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2. Une fenêtre vous demande de choisir une boîte de jeu (Game Box) pour votre scénario.  Sélectionnez le fichier gamebox dont vous avez besoin et cliquez sur Open/Ouvrir.
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3. Cela ouvre une fenêtre "projet" (Scenario Project), dans laquelle sont présentées et manipulées la plupart des informations contenues dans un fichier Scenario.  
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4. Choisissez dans la liste proposée la rubrique Game Scenario et cliquez au bas de la liste sur Properties. Dans le dialogue Scenario Properties, remplissez les cases d'information (créateur du scénario, titre, descriptif) puis cliquez sur OK.
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5. Choisissez ensuite la rubrique Playing Boards (Plateaux) et cliquez sur Select. Le dialogue Select Boards vous permet de sélectionner les plateaux de jeu utilisés par votre scénario.  Des cases à cocher, devant chaque plateau disponible dans la boîte, vous permettent d'en sélectionner plusieurs. Cliquez sur OK après avoir coché les cases voulues.
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6. Enfin, la rubrique Playing Piece Trays permet de créer autant de casiers de rangement que vous le souhaitez pour y placer les pions et marqueurs de votre scénario. Toute pièce utilisée dans un jeu doit d'abord avoir été placée dans un casier. Cliquez sur Create pour créer un nouveau casier. Donnez-lui un nom dans le dialogue Create Tray et cliquez OK. 
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7. Dans la liste, vous voyez maintenant tous les nouveaux casiers ainsi créés, sous le titre Playing Piece Trays, et dans la rubrique Playing Boards tous les plateaux sélectionnés.
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8. Sélectionnez le nom d'un casier de rangement que vous venez de créer et cliquez sur Edit. Le dialogue Setup Pieces vous permet de transférer des pièces depuis leur Groupe (dans la boîte de jeu) vers votre casier de rangement.
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9. Quand vous avez tout organisé, dans le menu File sélectionnez Save pour sauvegarder votre nouveau scénario sous un nom de votre choix.  Cliquez sur Save pour terminer.
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Ouverture et Modification d'un Scénario existant

1. Sélectionnez le menu File -> Open.  Dans le dialogue Open sélectionnez le type Scenario Files (*.gsn) dans la liste du bas.
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2. Choisissez votre Scénario et cliquez sur Open. Vous ouvrez ainsi la fenêtre Scenario Project.
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3. Modifiez ou ajoutez les éléments et les informations que vous désirez, comme lors de la création du fichier scénario.  Veillez à sauvegarder votre fichier modifié.

Parties

Une fois créé le scenario, vous êtes prêt à jouer une partie. L'état de la partie est conservé dans un fichier de partie, différent du fichier scénario. En vérité, dès qu'une partie est entamée son fichier scénario n'est plus nécessaire. Le fichier de partie (extension GAM) conserve tant l'état actuel de la partie que son historique complet. A tout moment vous pouvez réexaminer une série de tours précédents en lisant l'historique.

Création d'une Nouvelle Partie

1. Dans le menu File sélectionnez New. Dans le dialogue New choisissez Game et cliquez sur OK.
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2. On vous demande de choisir un scénario (Initial Scenario) comme point de départ de votre partie. Choisissez le Scénario que vous désirez jouer et cliquez sur Open. (Notez : une partie doit toujours débuter d'un fichier Scénario.)
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3. La fenêtre Game Project gère les informations principales contenues dans le fichier de partie (Game file) : nom de la partie, historique, éléments utilisés.
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4. Sauvegardez votre nouvelle partie par le menu File -> Save.  Dans le dialogue Save As, donnez-lui un nom et cliquez OK.
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Prise en cours d'une partie existante

1. Si le fichier de partie n'est pas ouvert, ouvrez-le par File -> Open.  Sélectionnez la partie en cours et cliquez Open.
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2. Si la boîte (gamebox) et les fichiers de parties ne sont pas dans le même dossier (ou même sur un autre disque), vous recevrez la mise en garde que voici.  Cliquez sur OK et indiquez au programme l'emplacement du fichier "boîte" (.gbx).
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3. A l'ouverture du fichier, la fenêtre Game Project est présentée. C'est à partir d'elle que se font toutes les opérations de jeu.
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4. Pour voir la situation de jeu, sélectionnez le plateau requis sous la rubrique Playing Boards et cliquez View.
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5. Les exemples qui suivent se basent sur le jeu Drive on Metz, présenté dans le chapitre 4 du livre de James F. Dunnigan, The Complete Wargames Handbook (disponible sur le web) 
 .  Cet exemple se limitera à une partie représentative de Drive on Metz. En effet, les règles spécifiques du jeu choisi déterminent exactement les mouvements et actions autorisés, sur papier comme dans CyberBoard.
Il vous revient donc de tenir compte des coûts de mouvement, tables de résolution et autres règles particulières à votre jeu.

NOTE:

Si vous souhaitez suivre cet exemple pas à pas, il est possible de télécharger la boîte et les scénarios de Drive of Metz à partir du site des Yankee Air Pirates, sur la page CyberBoard PBeM Support Page (http://members.home.com/yankeeap/ PBEM.HTM).  Les fichiers de Drive on Metz s'y trouvent, ainsi que des dizaines d'autres boîtes et scénarios de wargames créés par des amateurs.  Suivez simplement les instructions de téléchargement pour le(s) fichier(s) désiré(s).  Note : tous ces fichiers "boîte" et "scénarios" étant sous forme compressée, il vous faut disposer d'un outil de décompression de fichiers du genre WinZip ou PKUNZIP pour pouvoir lire les fichiers.
  


6. Dans le jeu Drive on Metz, les Américains posent leurs unités sur le plateau en début de partie, avant les phases de mouvement et de combat.  Pour placer des unités sur la carte, sélectionnez le menu View -> Tray Palette A (ou B).  Avec la souris, glissez chaque unité désirée sur le bord Ouest de la carte (dans Drive on Metz l'hex de placement compte comme premier hex de mouvement).
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7. L'unité étant posée sur la carte, sélectionnez l'option Begin a Plotted Move ("entamer un mouvement à la trace") dans le menu Actions.  Le curseur de la souris se transforme en viseur (+).  Cliquez successivement chaque hex par lequel doit passer votre unité.  Une ligne est dessinée le long du trajet choisi.
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8. Pour achever le mouvement de votre unité, sélectionnez Accept Plotted Move ("accepter mouvement à la trace") dans le menu Action.  L'unité est déplacée dans le dernier hex de son trajet.

[image: image23.png]3 Fle Edt View | Actions Playback Window Help

W € Move To Eront CHlF
| oo s

Fotate Fiece - Incremental
Tie  Rotate Piece - Absohte

Begin a CompaundMove  Chi+Enter

Discard Flotted Move.

RolDice.
Enter Message.

Recordthe plotted move

L=}
=181

NOM





9. Continuez de même pour chaque unité à déplacer.  Notez qu'un clic-droit sur l'unité sélectionnée vous propose un menu Action raccourci. (Si vous n'avez pas besoin de garder trace du trajet suivi, vous pouvez simplement déplacer les unités à la souris.)
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10. Lorsque toutes les unités US ont bougé, le jeu passe à la phase de Combat.  Dans notre exemple, les unités américaines 7A/CCA (hex 0406) et 5/10 (hex 0407) vont attaquer l'unité 462/1010 dans l'hex 0507.  Additionnons les points de force attaquants (12 points), pour les comparer à ceux du défenseur (1 point), cherchons la différence (12-1= +11) dans la table Combat Results Table (CRT) des règles de Drive on Metz, ce qui donne en l'occurrence la colonne 10+. Comptabilisons les effets de terrain qui réduisent ce rapport de 3 colonnes, donc le combat sera résolu sur la colonne +4/+5 de la CRT.
 Tout ceci est calculé par vous-même; il est utile d'écrire ce genre d'information dans un petit message à votre adversaire, avant le jet de dés (menu Enter Message).
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11. Pour la résolution du combat, cliquez sur le bouton Roll Dice ("jeter les dés") au bas du dialogue Send Message.  Un dialogue Roll Dice vous permet de sélectionner différentes options (nombre de dés, type, modificateurs).  Dans Drive on Metz le combat se résout par le jet d'un dé 6.  Cliquez Roll et vous obtenez un résultat entre 1 et 6.
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12. Le résultat aléatoire a donné “4”, ce qui est indiqué dans la partie "figée" de la fenêtre Message. Nous consultons la table de combat et trouvons le résultat “Défenseur recule d'un hex”. Mentionnez-le à votre adversaire dans la partie "libre" du message. 
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13. Cliquez Send & Close pour sauvegarder le message, et revenez à la partie pour exécuter le recul du défenseur.  Glissez l'unité 462/1010 avec la souris, de 0507 à 0606.  Choisissez par exemple l'unité US 5/10 pour avancer dans l'hex 0507.
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14. Après avoir résolu tous les combats de cette manière, le temps est venu de sauvegarder votre tour de jeu dans un fichier "tour de jeu" (game move, .gmv) et de l'envoyer à votre adversaire.  Dans le menu File sélectionnez Send Recorded Moves to File… ("envoyer tour de jeu enregistré vers un fichier").
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15. Nommez votre fichier "tour de jeu" dans le dialogue et cliquez Save. 

NOTE:  Il est recommandé de se mettre d'accord entre adversaires sur une convention de baptême des fichiers, pour faciliter le suivi de la partie en cours.  Par exemple, nous nommerons US01.gmv le fichier "tour de jeu" contenant le premier tour US.  A sa réception, le joueur allemand saura ce qu'il représente.  Après avoir joué son coup, il pourra le sauvegarder sous le nom GE01.gmv (pour German).  Au tour suivant, le joueur US enregistrera ses actions dans US02.gmv, et l'Allemand dans GE02.gmv.

En permettant de savoir constamment quel fichier contient quel tour de jeu, ceci permet d'éviter des confusions, mais aussi de reconstruire la partie si le fichier de partie devait être endommagé, effacé, ou pire (crash du disque dur,...).
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16. Quand vous cliquez sur le bouton Save pour enregistrer votre fichier "tour de jeu", le programme vous demande d'écrire un descriptif du coup joué.
Le Titre du tour de jeu sera affiché dans l'historique de la partie (rubrique Game History dans la fe​nêtre Projet), avec la date et l'heure où il a été non pas enregistré mais incorporé dans cet historique. La Description est une zone de texte libre pour exprimer vos commen​taires. Ceux-ci seront affichés lorsque le tour de jeu est sélectionné dans l'historique. 
Cliquez sur OK pour terminer.
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17. De retour dans la fenêtre Game Project, vous pouvez voir le tour de jeu dans la rubrique Game History.
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18. Il vous reste à sauvegarder le fichier de partie en cours et à envoyer le coup à votre adversaire.  Dans le menu File sélectionnez Save.  Comme le fichier de partie existe déjà, il ne vous demande pas de nommer le fichier.

19. Vous voilà avec un fichier de partie (.gam) et un fichier de tour de jeu (.gmv).  Normalement il ne faut envoyer que le fichier de tour de jeu à l'adversaire, mais pour le premier tour, il est recommandé de s'assurer que les deux joueurs utilisent le même fichier de partie. Pour cela, mettez-vous d'accord sur le scénario joué et sur le nom de partie, ou simplement envoyez une copie du fichier de partie avant d'y enregistrer vos premières actions (sinon le joueur allemand obtiendra une erreur en voulant charger votre tour de jeu à nouveau).
Pour envoyer des fichiers, attachez-les simplement en annexe à un message par e-mail. 

20. Allumons maintenant l'ordinateur du joueur allemand …

21. Zuper!  Le tour de l'adversaire vient d'arriver dans votre boîte-aux-lettres, et vous l'avez enregistré sur votre ordinateur. Voyons ce qu'il contient. Ouvrez le fichier de partie et dans le menu File sélectionnez Load Recorded Move File ("charger fichier 'tour de jeu'").
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22. Le dialogue vous demande le nom du fichier tour de jeu. Sélectionnez celui qui convient et cliquez Open.
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23. La fenêtre Game Project affiche le tour du joueur US dans la rubrique Historique, avec la date et l'heure, son titre et sa description telles que le joueur US les a enregistrés.
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24. Dans le menu Playback sélectionnez Next Move pour entamer la séquence de jeu du tour US.
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25. Les unités américaines commencent à apparaître sur le bord Ouest de la carte, puis vous les voyez se déplacer comme l'a ordonné votre adversaire.  Continuez à explorer le tour du joueur US en utilisant le menu Playback ou les icones de la barre d'outils.  Note : Next Move est activé par la touche F3.
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26. Après avoir visionné tout le tour de votre adversaire, il vous faut confirmer son incorporation dans l'historique de votre fichier de partie.  Dans le menu Playback sélectionnez Accept Move File Playback ("accepter déroulement du fichier tour de jeu").

[image: image38.png]=[ofx]

NI Fle Edi View Actions Plhack Window Help )
(ml-2 a A B =¥ &
[Game [Elements of the US th Infanity and 7th Armored Divisions assault and capture [ =]
[Playing Boards outer devensive works hed by the German 462nd Infanty Divison. The LS
Difve on Melz 501 fenty Divsion advances tonerd Thionvile:
[Game History

e Expot
NUM

For Help, press F1





27. Sauvegardez votre fichier de partie, et passez à l'exécution de votre tour de jeu comme décrit plus haut.

Références

Fenêtre Scénario (Scenario Project)

Au chargement d'un scénario vous pouvez voir la fenêtre Scénario (scenario project).  La liste à gauche présente le contenu du fichier scénario. La zone de droite montre en général des informations sur l'objet actuellement sélectionné dans la liste.

En sélectionnant un objet dans la liste de contenu, un ou plusieurs boutons en-dessous de la liste présentent les opérations possibles pour cet objet. Par exemple, pour visualiser un plateau de jeu, sélectionnez son nom dans la liste sous la rubrique Playing Boards et cliquez sur View. Cela ouvre une vue du plateau.

La liste de contenu d'un scénario propose les rubriques suivantes :

Game Scenario

Cette rubrique comprend l'information générale associée au fichier scénario. Un seul bouton est disponible:  

Properties – Affiche le dialogue d'édition des informations.
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Playing Boards

Cette rubrique sert à déterminer les plateaux de jeu utilisés dans ce scénario. Le seul bouton disponible est :   

Select – Affiche le dialogue de sélection.
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Noms des plateaux disponibles

La liste énumère les plateaux utilisés par le scénario. Les boutons sont :

View - Affiche une fenêtre de visualisation (Playing Board) du plateau. 

Properties - Affiche le dialogue d'informations Board Properties du plateau.

Remove – Efface ce plateau de la liste de plateaux disponibles dans le scénario.
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Playing Piece Trays

Les trays sont les casiers ou conteneurs où sont rangées les pièces. Chaque pièce utilisée dans un jeu a d'abord dû être placée dans un casier de rangement. Cette rubrique a un bouton :

Create - Affiche le dialogue de création de casier de rangement (Create Tray).
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Noms des casiers disponibles

La liste énumère les casiers de rangement actuellement définis dans le scénario. Lorsqu'un de ces noms est sélectionné, la partie de droite affiche le contenu actuel de ce casier. Les boutons sont :

Edit - Affiche le dialogue de sélection des pièces.

Properties - Affiche le dialogue d'informations Tray Properties.

Delete – Efface le casier de rangement et son contenu (après message de confirmation).
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Fenêtre Partie (Game Project)

Au chargement d'une partie vous voyez la fenêtre de contenu de la partie.  La liste à gauche présente les contenus du fichier de partie. La zone de droite montre en général des informations sur l'objet sélectionné dans la liste.

En sélectionnant un objet dans la liste de contenu, un ou plusieurs boutons en-dessous de la liste présentent les opérations possibles pour cet objet. Par exemple, pour visualiser un plateau de jeu, sélectionnez son nom dans la liste sous la rubrique Playing Boards et cliquez sur View. Cela ouvre une vue du plateau.

La liste de contenu d'une partie propose les rubriques suivantes :

Game

Cette rubrique affiche l'information relative à la partie en général. Il n'y a pas de bouton associé.
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Playing Boards

Affiche la liste des plateaux utilisés dans le jeu. Il n'y a pas de bouton associé.
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Noms des plateaux

Liste des plateaux en jeu. Les boutons sont les suivants :

View - Affiche la fenêtre de visualisation du plateau. 


Properties - Affiche le dialogue d'information Board Properties pour ce plateau.
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Game History

Cette rubrique contient l'historique de la partie. Il n'y a qu'un bouton:

Load – Pour sélectionner un fichier "tour de jeu" à charger et activer. Après le chargement, le programme se met en mode déroulement (playback) et vous pouvez visionner les actions enregistrées dans le fichier tour de jeu.
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<Move File Playback>Nom du tour de jeu

Cette rubrique est présente si un fichier "tour de jeu" a été chargé mais pas encore enregistré dans le fichier de partie. Les boutons sont les suivants :

Accept - pour accepter le tour de jeu et l'enregistrer dans le fichier de partie. 


Discard – pour refuser le tour de jeu et éliminer tout le fichier "tour de jeu".
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<Current Recording>

Cette rubrique est présente si vous avez exécuté des modifications ou des actions dans votre partie, mais sans les avoir encore enregistrées dans un fichier "tour de jeu". Les boutons sont :

Save – Enregistre les actions effectuées dans un fichier "tour de jeu" à envoyer à l'adversaire. 


Discard – pour rejeter toutes les actions mémorisées.
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[Date] [Heure] – Nom d'un tour de jeu

Présentées dans l'ordre chronologique, ces rubriques vous permettent d'accéder aux tours précédents et de revoir n'importe quelle partie de l'historique. Ils proposent les boutons suivants :

Replay – pour lancer le déroulement de cet ancien tour de jeu. 


Export – pour sauvegarder ce tour dans un fichier "tour de jeu" (.gmv).

[image: image50.png]=[ofx]

NI Fle Edi View Actions Plhack Window Help )
(ml-2 a A B =¥ &
[Game [Elements of the US th Infanity and 7th Armored Divisions assault and capture [ =]
[Playing Boards outer devensive works hed by the German 462nd Infanty Divison. The LS
Difve on Melz 501 fenty Divsion advances tonerd Thionvile:
[Game History

e Expot
NUM

For Help, press F1





<History Entry Playback>

Cette rubrique apparaît quand vous visionnez (playback mode) un des tours de jeu de l'historique. L'enregistrement concerné est marqué d'un chevron sur la gauche. Le seul bouton est :

Done – Sort du mode "déroulement de l'historique" (playback). L'enregistrement de votre tour de jeu reprend là où vous l'aviez laissé.
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Commandes des Menus

File Menu

New… [Nouveau]

Ouvre un dialogue de création d'un fichier scénario ou d'un fichier de partie.  Raccourci clavier – Ctrl+N

Open… [Ouvrir]

Ouvre un dialogue de sélection d'un scénario ou d'une partie existant(e). Raccourci clavier – Ctrl+O

Close [Fermer]

Referme le scénario ou le fichier de partie en cours.

Save [Enregistrer]

Sauvegarde le scénario ou le fichier de partie en cours.  Raccourci clavier – Ctrl+S

Save As… [Enregistrer sous]

Ouvre un dialogue d'enregistrement du scénario ou de la partie.

Recent Files Opened [Fichiers récents]

Affiche les quatre derniers fichiers de scénario ou de partie ouverts.

Exit [Quitter]

Ferme le module CBPlay.  Raccourci clavier – Ctrl+F4

Edit Menu

Copy Board Image to Clipboard [Copier image du plateau]

Crée une copie image du plateau en cours d'utilisation (y compris les unités et marqueurs disposés sur le plateau) dans le Clipboard Windows.  Raccourci clavier – Ctrl+C

Save Board Image in File… [Enregistrer image du plateau]

Ouvre un dialogue d'enregistrement du plateau en cours d'utilisation (y compris les unités et marqueurs disposés sur le plateau) dans un fichier Windows au format Bitmap (BMP).

Delete Markers [Effacer les marqueurs]

Retire du plateau de jeu tous les marqueurs sélectionnés.  Raccourci clavier – Delete

Select All Markers [Sélectionner tous les marqueurs]

Sélectionne tous les marqueurs actuellement posés sur le plateau.

Select All Markers From [Sélectionner tous les marqueurs de...]

Sélectionne tous les marqueurs actuellement posés sur le plateau qui sont issus d'un casier de marqueurs particulier.  Un submenu permet de choisir le casier de rangement désiré.


Board Properties… [Caractéristiques du plateau de jeu]

Ouvre le dialogue d'informations sur le plateau de jeu.

View Menu

Main Toolbar

Affiche/cache la barre d'outils.

Status Bar

Affiche/cache la barre de statut.

Snap Grid

Affiche/cache la grille de cases .

Tray Palette A

Affiche/cache la fenêtre de casiers A .

Tray Palette B

Affiche/cache la fenêtre de casiers B .

Marker Palette

Affiche/cache la fenêtre de casiers de marqueurs.

Full Scale Board

Visualisation du plateau de jeu en taille normale.

Half Scale Board

Visualisation du plateau de jeu à demi-taille.

Hide Pieces

Affiche/cache les unités et marqueurs.  Raccourci clavier – F9

Indicators on Top

Fait passer l'affichage des trajets des pièces au-dessus/en-dessous des pions.  Raccourci clavier – F10

Project Menu

(visible seulement dans un fichier scénario)

Create Playing Piece Tray

Ouvre le dialogue de création de casiers de rangement.

Create Trays from Piece Groups

Ouvre le dialogue d'importation des Groupes de pièces (raccourci utile si vos casiers de rangement respectent le même classement des pièces dans vos scénarios que dans la boîte de jeu). 
Select Game Boards

Ouvre le dialogue de Sélection de plateau.

Select Game Pieces

Ouvre le dialogue de Sélection des pièces .

Scenario Properties

Ouvre le dialogue d'informations sur le Scénario.


Actions

Auto Stack

Empile les pièces sélectionnées (selon le réglage Auto Stack défini dans le dialogue Board Properties).  Raccourci clavier – Ctrl+A

Move to Front

Affiche l'élément sélectionné sur la couche supérieure.  Raccourci clavier – Ctrl+F

Move to Back

Affiche l'élément sélectionné sur la couche inférieure.  Raccourci clavier – Ctrl+B

Turn Piece Over

Retourne l'unité sélectionnée si elle est double-face.  Raccourci clavier – Ctrl+I

Rotate Piece – Incremental

Ouvre le dialogue de Rotation de pièce .  Les pièces peuvent pivoter de 5, 10, ou 50 degrés, dans les deux sens.

Rotate Piece – Absolute
Ouvre un submenu proposant les sélections suivantes (raccourcis pour les orientations les plus fréquentes dans les wargames) :

Reset Rotation – annule la rotation de l'unité sélectionnée.

Square Faces – submenu de rotation de l'unité sélectionnée aux angles: 0, 90, 180, et 270 degrés.

Hex Faces (Flat Up) – submenu de rotation de l'unité sélectionnée aux angles: 60, 120, 240, et 300 degrés.

Hex Faces (Point Up) – submenu de rotation de l'unité sélectionnée aux angles: 30, 150, 210, et 330 degrés.

Diamond Faces– submenu de rotation de l'unité sélectionnée aux angles: 45, 135, 225, et 315 degrés.

Begin a Compound Move

(visible seulement dans un fichier de partie .GAM)

Commence l'enregistrement d'un mouvement composé, c'est-à-dire le rassemblement de plusieurs mouvements individuels en une seule action de déroulement, afin d'accélérer ce dernier. Raccourci clavier – Ctrl+Enter

Accept a Compound Move

(visible seulement dans un fichier de partie .GAM)

Termine le mouvement composé et l'engrange dans l'historique comme une seule action. Raccourci clavier – Enter

Discard a Compound Move

(visible seulement dans un fichier de partie .GAM)

Abandonne tout le mouvement composé et replace toutes les unités sélectionnées à leur position de départ.  Raccourci clavier - Esc

Begin a Plotted Move

(visible seulement dans un fichier de partie .GAM)

Commence l'enregistrement d'un mouvement à la trace, qui montre le chemin exact parcouru par l'unité.  

Accept a Plotted Move

(visible seulement dans un fichier de partie .GAM)

Termine le mouvement à la trace et l'engrange dans l'historique.

Discard a Plotted Move

(visible seulement dans un fichier de partie .GAM)

Abandonne tout le mouvement à la trace et replace l'unités sélectionnée à sa position de départ.

Roll Dice

(visible seulement dans un fichier de partie .GAM)

Ouvre le dialogue de Message , puis ouvre le dialogue de Jet de dés (Roll Dice). Raccourci clavier – Ctrl+R

Enter Message

(visible seulement dans un fichier de partie .GAM)

Ouvre le dialogue de Message . Raccourci clavier – Ctrl+M

Playback Menu

(visible seulement dans un fichier de partie .GAM)

Start of Moves

Retour au premier mouvement du tour ou du fichier "tour de jeu" visionné.  Raccourci clavier – F2

Next Move

Avancer d'un mouvement.  Raccourci clavier – F3

Previous Move

Revenir au mouvement précédent.  Raccourci clavier – F4

End of Moves

Passer à la fin de tous les mouvements enregistrés dans ce tour ou dans ce fichier "tour de jeu".  Raccourci clavier – F5

Single Step Compound Moves

Dérouler les mouvements composés pas-à-pas, par mouvement individuel. 


Next History Entry

Passer au tour (ou au fichier "tour de jeu") suivant dans l'historique.

Close History Playback

Terminer le déroulement de l'historique. 

Accept Move File Playback…

Accepter l'enregistrement du fichier "tour de jeu" dans l'historique.

Discard Move File Playback

Rejeter le fichier "tour de jeu" visionné.

Show Current Message

Afficher le dernier message dans le dialogue Message. 

Window Menu

Voir votre manuel Windows.

Help Menu

Voir votre manuel Windows.

Boutons de la Barre d'Outils
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De gauche à droite dans l'image ci-dessus, voici les commandes de menu disponibles en bouton:

Nouveau… Partie ou Scénario

Ouvrir… Partie ou Scénario

Enregistrer… Partie en cours ou Scénario

Envoyer enregistrement dans un fichier (Send Recording to File)

Charger fichier tour de jeu (Load Recorded Move File)

-  -  -  -

Début des Actions (F2)

Action précédente (F4)

Action suivante (F3)

Fin des Actions (F5)

Ouvrir Tour de jeu suivant dans l'Historique (F6)

Fermer Déroulement de l'Historique

- - - - -

Changement d'échelle de visualisation

(Ne pas) Montrer Pièces

- - - - -

Casier de rangement A

Casier de rangement B

Casier Marqueurs

- - - - -

Entamer Mouvement Composé (Ctrl+Enter)

Terminer Mouvement Composé (Enter)

Annuler Mouvement Composé (Esc)

- - - - -

Ecrire un Message (Ctrl+M)

Jeter les dés (Ctrl+R) 

- - - - -

Amener les Pièces au-dessus (Ctrl+F)

Renvoyer les Pièces en-dessous (Ctrl+B)

Emplilement Automatique (Ctrl+A)

Retourner la Pièce (Ctrl+I)

- - - - -

Enclencher/déclencher Contrainte de grille

� Larson, Dale. CyberBoard Web Page. 18 April 2000. http://www.execpc.com/~d-larson/cyberboard.html.


� Dunnigan, James F.  The Complete Wargames Handbook. 1997. http://www.hyw.com/Books/WargamesHandbook/Contents.htm


� WinZip is a registered trademark of WinZip Computing, Inc.  PKUNZIP is a registered trademark of PKWARE, Inc.
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